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In Windows 10, You can personalize the Desktop, the Start Menu, the Taskbar, and even the
Lock Screen

o True
@ False

SUBMIT ANSWER

Socrative Student Response by Mastel
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Windows 10 provides three views for the desktop icons; Large icons, Medium icons and

@ Extra Large Icons
Tile Icons
° Small Icons

SUBMIT ANSWER
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You can arrange icons manually by dragging icons as you want or you can let windows arrange
(or Sort) it automatically.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect .
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You can choose to sort icons automatically by their Name, Size, Item type or

@ Location
° Date modified
@ Color

SUBMIT ANSWER




B & & socative X+ v — b4

&~ = O o 5 bsocrative.com/student/#quiz H e v 4L =2 10

ALPHATEST444

50f 130

You can personalize the desktop background from the Windows Personalization Settings.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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In Windows 10, you can personalize your desktop background by choosing a Picture, a Solid
color, or a Slideshow of pictures.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect .
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You can also open the Personalization Settings by by right-clicking on the desktop and choosing
Personalize.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M
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You can personalize the desktop background from the

@ Windows Update and Security Settings

SUBMIT ANSWER
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To set a Picture for your desktop background, open the Personalization settings

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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To have a picture as the desktop background, you can choose a picture from the default
pictures provided by Windows 10 but you cannot browse your computer to locate the picture.

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can also right-click on the picture file and select Set as desktop background.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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To have a simple desktop Background, you can choose a from a variety of
available colors.

° Solid color
Solid picture
@ Solid slideshow

SUBMIT ANSWER
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If you want the desktop background picture to be changed automatically after a specific time
period, you can choose the option for your desktop background

@ Picture
° Slideshow
@ Solid Color

SUBMIT ANSWER
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To set a Slideshow as desktop background, you need to organize all your favorite pictures into a folder and
set it as a source for the Slideshow.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can set the option ON to display the pictures in the Slideshow in random order.

@ Rand
. Slide Order

° Shuffle

Repeat

SUBMIT ANSWER
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The option in Personalization settings allows you to change the appearance of
various user interface elements of Windows at once.

@ Colors
° Themes
@ Background
@ Taskbar

SUBMIT ANSWER
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The is like a personalization package containing the desktop backgrounds, colors,
screen savers, and even system sounds

Solid Color
Theme

@ Background

Slideshow

SUBMIT ANSWER
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Applying a theme instantly changes the look and feel of the Windows environment.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can set a Picture or a Slideshow on the Lock Screen in the same way you do it for the desktop
background

o True
@ False

SUBMIT ANSWER
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You cannot set a Picture or a Slideshow on the Lock Screen from the Personalization settings

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can show the status of different apps right on the Lock Screen

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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Windows 10 allows you to show detailed status of any one app and quick status of up to seven
apps on the Lock Screen.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect .
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Setting an app to show on the Lock Screen gives a bit more information
from the app

° detailed status
quick status

SUBMIT ANSWER
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The detailed status of shows the upcoming event details which includes the event
title, location, time, etc.

° Calendar app
o Weather app
@ Messaging app

SUBMIT ANSWER
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You can download more themes from the Microsoft website

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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The option from the Settings app displays the app icons for the new
notifications on the Lock Screen.

° Choose apps to show quick status

Choose apps to show detailed status

Socrative Student Response by MasteryConnect .
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The Choose apps to show quick status option from the Settings app displays the app icons for the
new notifications on the .

° Lock Screen
Login Screen
@ Desktop

SUBMIT ANSWER
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The count of the notifications is also displayed on the app icon, which is called of
the apps.

thumbnai
badges
icon number

app number

Ol0] - 10,

SUBMIT ANSWER
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The quick status of email app shows just the number of new emails arrived.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect

B &8 & socrative X [+ v =

& > 0O @a B bsocrative.com/stu

30 0f 130

The Settings app of Windows 10 has made configuring the Start menu quick and simple, by
providing the ON/OFF buttons for most of the options

° Toggle

Green/Red
@ Switch
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Turn this option ON if you want to make the Start screen a bit wider to occupy more tiles

° Show more tiles

. Use Start full Screen
@ Show most used apps

Show recently added apps

SUBMIT ANSWER
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Turn this option ON to see a list of apps you use most but are not pinned to the Start screen, at
the top of the All Apps list

@ Show more tiles
. Use Start full Screen

° Show most used apps

Show recently added apps
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Turn this option ON to see a list of recently installed apps, at the top of the All Apps list

@ Show more tiles
. Use Start full Screen

@ Show most used apps

Show recently added apps

SUBMIT ANSWER
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Turn this option ON to see the full screen Start Menu as in the tablet mode.

®
@
©
®

Show more tiles

Use Start full Screen

Show most used apps

Show recently added apps

SUBMIT ANSWER
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Windows 10 cannot Show recently opened items in Jump Lists on Start or the Taskbar

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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Turn this option ON if you want to prevent any accidental relocation or resizing of the Taskbar.

Use small taskbar buttons

. Show badges
° Lock the Taskbar

ONO

Taskbar location on screen
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Turn this option ON if you don't want the taskbar to be always visible. Instead, it will appear only
when you move your mouse pointer over the taskbar location

Lock the Taskbar
Taskbar location on screen

Show badges

Automatically hide the taskbar in desktop mode

SUBMIT ANSWER
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Turn this option ON if you want the buttons on the taskbar to be a bit smaller. This reduces the
size of the taskbar as well.

@ Lock the Taskbar
. Taskbar location on screen

@ Show badges

Use small taskbar buttons

SUBMIT ANSWER
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Turn this option ON if you want to get the count of any new notifications from a running app
directly on its taskbar button

Lock the Taskbar
Taskbar location on screen

Show badges

Automatically hide the taskbar in desktop mode

SUBMIT ANSWER
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You cannot change the location of the taskbar on your screen.

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can also lock the taskbar by right click on it and choose Lock the taskbar.

° True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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You can also open the Taskbar Settings by Right-click on the taskbar and choose Settings

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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This allows you to occupy more buttons on the taskbar

@ Taskbar location on screen
Combine taskbar buttons
° Lock the Taskbar

SUBMIT ANSWER
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This allows you to occupy more buttons on the taskbar

@ Taskbar location on screen
° Combine taskbar buttons
@ Lock the Taskbar

SUBMIT ANSWER
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option allows to always combine the taskbar buttons for the apps. This also
hides the labels of all the apps on the taskbar buttons.

° Always, hide labels
° When taskbar is full
@ Never

SUBMIT ANSWER
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option allows to only combine the taskbar buttons for the apps when the taskbar is
full of buttons.

@ Always, hide labels
° When taskbar is full

@ Never

SUBMIT ANSWER
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option does not combine the taskbar buttons even if the taskbar is full of buttons.

° Never
Always, hide labels

@ When taskbar is full
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This option allows to choose which system icons you want to appear in the Notification Area of
the Taskbar, such as the Clock, Volume, or Network.

®)
@
©
&)

Show badges

Turn System icons ON/OFF

Combine taskbar buttons

Taskbar location on screen
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is a rectangular frame that displays apps, files, folders, or other contents.
Badges
Window

Taskbar

Action center

SUBMIT ANSWER
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The window you are currently working in is called an

@ Window Border
° Active Window
@ Title Window

SUBMIT ANSWER
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If you are currently browsing a website in Microsoft Edge, it is your active window.

° True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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The contents of every window are usually different but all windows have some common
characteristics

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M

B & £ socrative X 4+ v - 8 X

< = 0O h B bsocrative.com/student/#quiz B e = 7 = u

ALPHATEST444

52 of 130

It is the area at the top of a window that displays the title of an app. It also displays the title of
the file, which is open in the window

@ Minimize button
o Title Bar
@ Window Border

SUBMIT ANSWER
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Question:

It minimizes a window to the taskbar, i.e. the window
disappears from the screen. You can re-open the
same window from the taskbar.

Correct Answer:
Minimize button
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It closes the window along with the file, or any other contents.

@ Minimize button

Close button

@ Restore button
@ Maximize button
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is used to move vertically or horizontally to change the position of the content
within a window

@ Window Border
Title Bar
@ Minimize button

° Scroll Bar

B S $ socative X 4+ v - X

L O 5 b.soerative.com/student/zquiz

=4
b
g
o
B
a

ALPHATEST444

56 of 130

You use vertical or horizontal scroll bars to move through a window.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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The outer edges of a window, which specifies area of the window on the screen
is

@ Title Bar
° Window Border

@ Minimize button
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The Window borders can be used to resize a window as well

° True
@ False

SUBMIT ANSWER
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Windows 10 allows you to automatically arrange all running app windows in three ways;
cascade, stacked, or

@ straight
° side by side
@ vertical

SUBMIT ANSWER

B & § socrative X 4+ v - x
R O £ bsocrative.com/student/#quiz o Y ¥ L 2 0

ALPHATEST444

60 of 130

This arrangement shows multiple open windows overlapped one over the other.

@ Show windows stacked
° Cascade windows
@ Show windows side by side

SUBMIT ANSWER
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This arrangement shows the multiple windows one above the other

@ Cascade windows
° Show windows stacked
@ Show windows side by side

SUBMIT ANSWER
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The Cascade windows shows multiple windows arranged side by side.

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect
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After you have arranged multiple windows on your screen, you can restore them to their
previous status by choosing the relevant Undo command

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M

B & § socrative X 4+ v - x
R O £ bsocrative.com/student/#quiz o Y ¥ L 2 0

ALPHATEST444

64 of 130

Snapping a window to left or right side actually resizes and positions a window to occupy either
left or right portion of the screen or one corner of the screen

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect .
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To snap window to left half of the screen, you need to drag the window Title bar until the mouse
pointer touches the left or right edge of the screen (A circle flashes around mouse pointer) and
Release.

° True
@ False

SUBMIT ANSWER
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To snap a window to a , drag the window title bar until the pointer touches a corner
of the screen and release.

° quarter screen
full screen
@ half screen

SUBMIT ANSWER
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You cannot cycle through different windows that are open on your screen or minimized to
Taskbar

@ True
° False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M
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To switch between windows, you can use the button on the taskbar.
Task View

Action Center

Search

Start

Ol0l0] -

SUBMIT ANSWER
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The main function of the Task View button is to provide easy switching amongst the different
open windows.

o True
@ False

SUBMIT ANSWER
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You can also switch among the open windows easily with the keys

shift + tab

alt + tab

ctrl + tab

alt + shift

ORO! - 1O

SUBMIT ANSWER
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When you click the Task View button on the taskbar, Windows displays thumbnails for all
running programs.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M
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MANAGING FILES & FOLDERS AND COMPUTER SETTINGS--SESSION 6

A is a collection of related data or information stored in a computer;
identified by a name

@ liberary
O -
@ home tab

SUBMIT ANSWER
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It can be a document, worksheet, graph, text file, presentation, audio clip, video clip, etc

° File
Folder
@ Liberary

SUBMIT ANSWER
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is a container in which you can store files and folders
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A folder within a folder is called a
Folder
Sub-folder

File

Ol0] - 10,

Liberary

SUBMIT ANSWER
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allow you to access and arrange files from different folder locations quickly
without moving them from their original location

Folder

Libraries

Sub-folder

File

SUBMIT ANSWER
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The default libraries in Windows 10 are Documents, Music, Pictures, Videos, Camera Roll and

)
\A ) File Explorer

(
v

° Saved Pictures

N

[ € ) HomeTab

-

Socrative Student Response by MasteryConnect
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The is the file management application used by Windows 10 to browse folders
and files.

Documents
File Explorer
Quick Access

Liberary

Q0] - 10,

944 PM

4y b ENG - =
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File Explorer provides a graphical interface for the users to navigate and access the files stored
in the computer.

o True
@ False

SUBMIT ANSWER

Socrative Student Response by MasteryConnect M
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If you are looking for a specific document in your computer use the File Explorer to locate it.

° True
@ False

SUBMIT ANSWER
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The keyboard shortcut to open the File Explore is

° Windows logo key + E.
alt+shift
@ ctri+shift

SUBMIT ANSWER
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In the File Explorer app, the contains buttons for the common tasks you perform
with your files and folders

° Ribbon
Content Pane
@ Scroll Bar

SUBMIT ANSWER
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It lets you navigate through the folder structure easily and search files or folders.

° Navigation and Search Bar

Content Pane

Ribbon

Refresh button

SUBMIT ANSWER

@O

B S $ socative X 4+ v - X

L O 5 b.soerative.com/student/zquiz

=4
b
g
o
B
a

ALPHATEST444

85 of 130

It gives you easy access to storage structure of your computer consisting of the libraries of
documents, pictures, storage devices and even network devices.

@ Ribbon

Refresh button
° Navigation Pane
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It is the main area to the right of the Navigation Pane that displays the contents of the selected
folder or storage location

@ Ribbon
. Navigation and Search Bar

@ Navigation Pane

Contents Pane
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It actually opens the File menu that has options like managing the File Explorer window or
customize the File Explorer

° File tab
. Home tab

Share tab

@ View tab
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In File Explorer, the has most of the tools to organize files and folders

@ File tab

o Home tab

@ Share tab

@ View tab
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The has the options like Share, Email, Print, or Compress a file or folder
@ File tab

° Share tab

@ Home tab

@ View tab
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The has the options to configure the layout of the File Explorer window.

Share tab

®
©
o

Home tab

View tab
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The Navigation and Search bar below the Ribbon helps you in navigating through your folder and searching
for files.

° True
@ False
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The allows you to browse folders and files on your computer or on a network.
Navigation pane

Share tab

ORO! -

Home tab
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The node contains links to folders and libraries that you access frequently

@ This PC
° Quick Access
@ Network
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The node contains links to your user account-specific folders, and to the
physical storage locations that are installed in or connected to your computer

@ Quick Access

° This PC
@ Network
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The node displays a representation of other computers on your local area network.

° Network
Quick Access

@ This PC
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In File Explorer, the displays files and folders stored in the currently selected
folder or storage device

° Content Pane
. Navigation pane

@ Share tab

Home tab
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The Contents pane displays the contents of the selected folder as a textual or iconic list

o True
@ False
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The section lists the folders you've worked with recently, for quick access to them

@ Recent files
e Frequent folders
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The section lists files and documents that you've opened recently.
Frequent folders

Recent files
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This group consists of commands to copy or move a file/ folder.

° Clipboard
. Organize

©
®

New

Open
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This group consists of commands to copy, move, rename, or delete a file/ folder.

or

Organize
Clipboard

Open

@
©
®
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This group consists of commands to create a file/ folder or other items

@ Organize
. Clipboard

0 -
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This group consists of commands to open a file/ folder or display its Properties.
Clipboard

Organize

- BEONOIO

Open
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This group consists of commands to select the files/ folders in the content pane.

@ Clipboard
. Organize

©
@

New

Select
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Quick Access node in the Navigation pane gives you a quick way to open frequently used folders

° True
@ False
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In the File Explorer, you can use the button on the Home tab to easily pin any
folders location to the Quick Access list

° Pin to Quick Access
. Move to

@ Copy to

Select all
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When you cut or copy a folder or file, the item is moved to a storage area called the

@ Organize
° Clipboard
@ Layout
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You cannot copy or move a file from one folder to another

@ True
° False
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The group facilitates you to perform different operations such as Copy, Move,
Rename and

Delete in an efficient way.

Clipboard

Open

Organize

Select
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You can Recycle or Permanently delete files or folders that you don’t need any more.

o True
@ False
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If you want to delete multiple items at once, select them and press DELETE key on your
keyboard.

o True
@ False
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When you delete a file or folder, Windows 10 moves the object to the Recycle Bin.

o True
@ False
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You cannot change the name of any file or folder based on changes in its contents at any time
you want

@ True
° False
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The New group facilitates you to create new Folders or Files as per your requirement.

o True
@ False
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You can create blank files of different types in File Explorer, which can be opened and edited in
the respective application.

o True
@ False
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The Select group facilitates you to select multiple files or folders from the content pane.

o True
@ False
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In the File Explorer, The tab hosts the commands that you can use to customize the
display of items in the File Explorer window.

Home
View

File

Share
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The View tab allows you to change the way Windows displays your files and folders

o True
@ False
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In the View Tab, the group facilitates you to Show/Hide the Navigation Pane
Panes
Layout

Current view

Q0] -
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The group enables you to choose among the different icon sizes and their Details.

° Layout
. Panes

@ Current view

Show/hide
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The Panes group facilitates you to access Details or Preview panes

° True
@ False
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When the Preview pane is active, clicking on a file displays its content in the pane on the right
side.

o True
@ False
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If the Details pane is active, clicking on a file displays its detailed information in the pane on the
right side.

o True
@ False
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The options in the group allows you to choose whether the contents of a folder are
displayed as icons of various sizes such as Extra-Large, Large, Medium, Small icons or as a List,

Details, Tiles or Content view.

@ Panes
° Layout
@ Current View
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By default, the Libraries are hidden in Windows File Explorer

o True
@ False
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You can open the newly created library and click on Include a Folder button to browse for and
add the first folder to the library.

o True
@ False
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Time and Language option in the Windows Settings app allows you to set or change your System
Date, Time, Region, Language and Speech settings.

o True
@ False
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In Windows 10, the Settings enable you to change the country or region, and to
add or remove languages from the system.

@ Date & Time
° Region & Language
@ Speech
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In Windows 10 Settings, The Languages option allows you to install new languages

° True
@ False
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You can display the System Information, from Windows Settings App

o True
@ False
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